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How to Use Excel Like 
the Cool Kids 

A guide by Dominic 

 

Microsoft Excel. It’s capable of doing just about anything, but to use it, it feels like you need a Ph.D. 

Excel is so ubiquitous in the worlds of business, science, engineering, and medicine that I can say with 
confidence that it is one skill you absolutely will use after you graduate. Yet, most students come to 
college with little experience using it. So here’s a quick intro guide to some fun things you can do in 
Excel. It ought to help you work through homework assignments not just in the class, but for the rest of 
all time. 

Throughout this document, I’ll use large blue headings for big topics and smaller grey headings for 
individual skills. It should make it easier to skip the skills that you are already familiar with so you can get 
to the good stuff. I’ve tried my best to make it readable, too, so it shouldn’t be total torture to go end to 
end. 

Look for the magic rectangle in images to help direct your eyes. Whenever you see the magic rectangle, 
you’ll know that whatever it’s surrounding is what I’m trying to show you.  

 
What a magic rectangle might look like 

 

As usual, remember that course staff is here to help. If anything in this guide is unclear, please ask. 
Likewise, if there’s anything you think is missing, let us know and we’ll be able to make this guide even 
better. 

<3  



 
2 

 

Contents 
The Basics ...................................................................................................................................................... 4 

The Excel Window ..................................................................................................................................... 4 

The Ribbon ................................................................................................................................................ 5 

Working with Cells and Selections ............................................................................................................ 6 

How to Find More Information Online ..................................................................................................... 7 

Formulae and Functions ............................................................................................................................... 8 

Formulas ................................................................................................................................................... 8 

Order of Operations ................................................................................................................................ 10 

Copying and Pasting ................................................................................................................................ 10 

Absolute and Relative References .......................................................................................................... 11 

Functions ................................................................................................................................................. 12 

Finding the Best Function for Your Lifestyle ........................................................................................... 13 

Sheets .......................................................................................................................................................... 15 

Adding and Deleting Rows or Columns ................................................................................................... 15 

Adding Sheets ......................................................................................................................................... 16 

Renaming and Labeling Sheets ............................................................................................................... 17 

Copying, Deleting and Reordering Sheets .............................................................................................. 18 

Split ......................................................................................................................................................... 19 

Hide ......................................................................................................................................................... 20 

Freeze Panes ........................................................................................................................................... 21 

Fomatting .................................................................................................................................................... 22 

The Format Cells Dialog .......................................................................................................................... 22 

Adjusting Decimal Places ........................................................................................................................ 25 

Cell Styles ................................................................................................................................................ 26 

Show All Formulae .................................................................................................................................. 27 

Tables .......................................................................................................................................................... 28 

Creating Tables........................................................................................................................................ 28 

Sorting and Filtering ................................................................................................................................ 30 

Table Styles ............................................................................................................................................. 32 

Remove a Table ....................................................................................................................................... 32 

Graphs and Charts ....................................................................................................................................... 33 

Inserting a Chart ...................................................................................................................................... 33 



 
3 

 

Changing or Adding Data ........................................................................................................................ 35 

Trendlines ............................................................................................................................................... 37 

Error Bars ................................................................................................................................................ 40 

Axis and Chart Labels .............................................................................................................................. 42 

Exporting a Chart to Microsoft Word or Powerpoint ............................................................................. 43 

Other File Formats ...................................................................................................................................... 44 

Opening a CSV File .................................................................................................................................. 44 

Opening a TXT File ................................................................................................................................... 46 

Keyboard Shortcuts ..................................................................................................................................... 50 

Basic ........................................................................................................................................................ 50 

Function Keys .......................................................................................................................................... 51 

Functions of Interest ................................................................................................................................... 52 

List of Functions ...................................................................................................................................... 52 

Further Reading .......................................................................................................................................... 54 

 

  



 
4 

 

The Basics 

Okay, let’s start with some easy stuff.  

 

The Excel Window 

 

When you first open Excel, you’ll be greeted with a big blank spreadsheet, in white above. 

Each rectangle in the spreadsheet is called a cell. 

The columns and rows are named using letters and numbers, respectively. Each cell is labeled according 
to its position. The cell highlighted in green above is cell A1. It lives in column A and row 1. 
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The Ribbon 

 

The top section, in a medium grey above, is called the ribbon. This is where many of the options for 
Excel live. Depending on how wide your monitor is, you may see more or fewer buttons up here. 

You can click each word in the menu bar right above the ribbon to change its tab. Right now it’s on the 
Home tab, but there are many options. Click through them as you read and get a feel for where 
everything is. 

File changes the window to show options like Save, Print, Share, and Settings. To exit the File tab, you 
need to click the “back” arrow in the upper left. 

Home contains commonly used formatting options and some basic editing tasks. 

Insert contains buttons for adding images, graphs, tables, and other doodads. 

Page Layout contains options useful for printing and display. 

Formulas contains lists of functions that excel can perform. 

Data contains tools for importing data from various sources and for sorting and otherwise working with 
data already in the spreadsheet. 

Review contains tools for reviewers to comment on and change a spreadsheet while keeping track of 
every change that’s made. 

View contains settings that change the way the spreadsheet appears on screen. 

Help contains its own training modules and advice about Excel. 

Other tabs may also appear depending on other programs you have installed on your computer. 

You can double click on a tab name like Home or Insert to make the ribbon appear or hide. Sometimes 
you want more screen space for your spreadsheet, and sometimes you want clickable ribbon buttons 
immediately available, so don’t be afraid to change the mode frequently. 
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Working with Cells and Selections 

When your mouse it over a cell in the spreadsheet, it will turn into a thick cross: 

 

This cursor indicates that you can select one or more cells. You can click to select just one or click and 
drag to select a range. Ranges can be linear, consisting of cells in the same row or column, or they can 
be rectangular in shape, depending on where you click and drag to. 

If you hold CTRL, you can select multiple cells that aren’t connected at the same time. Try selecting cells 
B1, B3, and B5 all at the same time this way. 

If you hold your mouse over the row and column headers, the cursor changes to an arrow: 

   

This cursor indicates that you can click to select the entire row or column. Like before, you can click and 
drag to select multiple rows or columns. You can also hold CTRL to select multiple unconnected rows 
and columns. 

Try selecting Column A, Row 3, and cell D5 all at the same time. 

Once you’ve made a selection, you can use CTRL+X, CTRL+C, and CTRL+V to cut, copy, and paste the cells 
around the spreadsheet. 

 

You can also use the arrow keys on your keyboard to move around the spreadsheet. Hold shift to select 
the cells you move through just like you were clicking and dragging with the mouse. 

  



 
7 

 

How to Find More Information Online 

When searching for more information online, you should follow these steps to be sure you’re getting the 
best help. 

1. Take note of which version of Excel you’re using. You can find your Excel version by clicking File 
in the ribbon, then Account near the bottom left of the window, and the checking the product 
version under the Microsoft or Office logo.  

 
I’m running the Microsoft 365 version of Excel.  
 

2. Check the Office Website first. https://support.office.com/en-us/excel contains lots of well 
written guides for you. Simply type a function name or any question you have into the search 
bar. 
 

3. If you must use Google, begin your search with the version number of Excel you’re using. For 
example: “Excel 365 IF function” 

https://support.office.com/en-us/excel
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Formulae and Functions 

Formulas 

Let’s try entering some information into a cell, shall we? Copy the data below into your own 
spreadsheet. Just click each cell and start typing. 

 

When you type into a cell directly, Excel assumes that what you’re typing is a number if you enter only 
numbers. If you enter other characters, Excel will assume you’re typing words. 

If you like, you can also enter numbers and text into a cell by clicking the cell and then typing in the 
formula bar. This can be useful because the formula bar is usually much wider than a given cell, so it’s 
easier to see what you’re typing. 

 

Notice that when you highlight a cell, its formula always appears in the formula bar. 

  



 
9 

 

If you want Excel to do any thinking, you need to begin any cell with an “equals” character, “=”. This tells 
excel that you are typing in a formula that you want it to solve. 

Click on cell B1 and type the following, then press enter: 

=A1 

Notice that B1 now displays “1”. If you change cell A1 to “3”, B1 will also change to “3”. 

Now enter the following in cell B2 and press enter: 

=A2+A3 

Excel knows basic formulas that you can type like this. As long as you put an “=” at the start, excel will 
try to do the math that you enter. There are several other symbols Excel recognizes, for example: 

+ for addition 
- for subtraction 
* for multiplication 

/ for division 
^ for exponents 
() for use as mathematical parentheses 

In addition to entering cell locations directly, you can also click on a cell to add it into a formula you are 
editing. Click on cell B3, type “=”, then click cell A4, then type “+”, then click cell A5. Notice that Excel 
filled the cells as you were editing, and that it also color-codes the cells. 
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Order of Operations 

When Excel goes through a formula, it uses the standard PEMDAS (or BEDMAS) order of operations that 
you learned in grade school: parentheses first, the exponents, then multiplication/division, then 
addition/subtraction. It will perform each category, in order, from left to right. For longer formulas, it’s 
always a good idea to add more parentheses so you can be sure Excel is doing the calculation the way 
you expect. 

 

Copying and Pasting 

When you copy and paste a formula, Excel will try to adjust the references for each new cell you paste 
into. Try filling in this spreadsheet: 

 

When you press enter on cell A4, it will calculate the answer for you. If you copy cell A4 into cells B4 and 
C4, Excel adjusts the formula accordingly to calculate the sums B1+B2 and C1+C2, respectively. 
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Absolute and Relative References 

By default, Excel uses Relative Reference in formulas. This means when you copy and paste a cell to a 
new location, the references change accordingly. If you wish to prevent this from happening, you can 
use Absolute References instead. 

Copy the following spreadsheet: 

 

Now copy cell A4 into cells B4 and C4. Notice that the references changed. Now edit cell A4 as follows: 

 

Again, copy cell A4 into cells B4 and C4. You’ll notice this time that the references did not change. 

 

Adding a dollar sign ($) before the column and row makes the reference Absolute. These values will not 
change when you copy and paste or move the formula around the spreadsheet. You can mix & match 
absolute and relative references as you wish in a given formula.  

Additionally, you can create Mixed References by adding the dollar sign before only the column or only 
the row in a single reference. For example, A$1 will change column if the cell is copied into a new 
column, but it will not change row even if the cell is copied into a new row. 

When typing a reference, you can press F4 to automatically cycle between relative, absolute, and mixed 
reference types. 
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Functions 

For more complicated operations, you need to use functions. Functions are built-in operations that 
excel can perform. Excel 2019 currently has over 500 functions. For this class you will need to memorize 
all of them. Just kidding. We’ll go over some of the easy ones here, though. Work through on your own 
spreadsheet to see what happens. 

All functions work about the same way. After the equals sign, you type the name of the function 
(usually in all caps) followed by its arguments in parentheses. We’ll explain using the SUM function.  

 

The calculate the sum of cells A1 and A2 above, we type “=SUM(A1,A2)” into cell A4. We can also select 
more than two cells if we like: 

 

Here we’ve selected a range of cells by typing “=SUM(“ and then clicking and dragging over the range, 
the typing “)”. We can even select multiple ranges, or a combination of ranges and cells, by separating 
each with a comma. Try to duplicate this spreadsheet by entering the single digit numbers and using a 
single SUM function in cell A7: 
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Finding the Best Function for Your Lifestyle 

A list of functions that are particularly useful to a chemistry student can be found at the end of this 
document. If you know the name of the function you want to use, typing it in as above is usually the 
fastest way to use it. 

If you are trying to find a specific function and don’t know the name, the best way to do so is to use the 
Insert Function dialog. You can access it by clicking the fx button next to the formula bar: 

 

 

The Insert Function dialog contains a list of each function available in Excel, as well as several ways to 
search for the function you’re looking for. This dialog also gives instructions for using each function. 
Notice above that the SUM function requires at least two numbers as arguments, but can take more, 
represented by the “…”. 
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Alternatively, you can select the function and click “OK” to bring up the Arguments dialog. Selecting 
SUM gives the following: 

 

We can type in actual numbers for each argument, or we can type cell names and ranges. If we want to 
select a cell or range of cells with our mouse, we can click the  button, select the range we’re 
interested in, and then press enter. 

 

Note a couple things: Since SUM takes as many arguments as you like, Excel adds a line as you fill them. 
Excel also displays the values of each cell as you select them to help you stay organized. Finally, Excel 
displays the result of the formula at the bottom for you to check. Click “OK” to insert the function into 
the spreadsheet. 
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Sheets 

As your spreadsheets become more complicated and more densely packed with data, you’ll need some 
special tools to help you organize and understand everything. Excel is packed with many helpful tricks 
that will make working with large amounts of data easier. 

 

Adding and Deleting Rows or Columns 

Sometimes, you’ll have a large amount of data in a spreadsheet and realize you need to squeeze an 
extra row or column in there. By adding a new row or column, Excel will slide everything out of the way 
and keep all your existing references and formulae intact. 

To add a new column, simply right click on the column header, then click Insert. The new column will be 
inserted to the left of the column you selected. 

   

The same procedure works for adding rows. In that case, the new row will be added above the row you 
select. 
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Adding Sheets 

Excel can save multiple spreadsheets to the same file. This can be useful for separating sections of you 
work or for keeping different sets of related data in the same file. 

When you first open a file, Excel creates one spreadsheet and puts a tab for it in the lower left: 

 

To add an additional sheet, just click the  icon next to the tab. The new tab appears to the far right. 

Your new spreadsheet will be saved with the existing one in the same file and you can switch between 
them at any time. Cells in one sheet can reference cells in any other sheet, too: while editing a formula, 
you can change tabs and click cells just as you’ve done before.  
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Renaming and Labeling Sheets 

If you’d like, you can change the labels on your sheets to make it easier to keep track of them. 

    

Just right click on the tab and select Rename, then type your new name and hit enter. You can also use 
the Tab Color option to add a highlight to your tabs. 
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Copying, Deleting and Reordering Sheets 

Once you’ve got several tabs, you can move them around by simply dragging the tabs. Alternatively, you 
can right click a tab and select Move or Copy. 

   

You’ll see the dialog box above, which allows you to select the precise location you’d like to move your 
tab to. If you check the Create a copy tickbox, Excel will add a new copy of the sheet to the location you 
select while leaving the current copy where it is. 

Note that you can also use this function to easily move or copy tabs between open files. The To book: 
dropdown box will list all the Excel files you currently have open, allowing you to pick whichever you 
like. 

To delete a tab, simply select the Delete option on the same right click menu. Be careful: Excel does not 
let you undo a deletion like this. 
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Split 

If your data takes up more room than you have on your screen, you obviously won’t be able to view it all 
at once. But what if you want to look at different parts of your data that aren’t close enough to fit on 
screen at the same time? For this, we use the Split option. 

 

First, click cell C3 in your spreadsheet. Then, switch your ribbon to the View tab and select the Split 
button. You’ll notice that some gray lines appear. 

 

Those gray lines separate your spreadsheet into four separate split-windows. Each has its own scrollbars 
and can be moved independently. You can click and drag on the gray borders to make each split 
whatever size you choose. 

If you wish to get rid of a split, you can simply double-click the border. If you want to get rid of all splits, 
you can click the Split button in the View ribbon again. 

If you only want a horizontal or vertical split, you can first select a cell in row 1 or column A. 

  



 
20 

 

Hide 

If you have several rows or columns that you don’t want cluttering up your screen, you can hide them by 
right clicking the row or column header and selecting Hide. 

   

You’ll notice that the column names didn’t change. In our example, Excel appears to skip from column B 
to column C. All data in and any references to column C will still work, Excel is simply not displaying the 
column to you. 

If you want to view a hidden column or row again, you should select a set of multiple columns or rows 
that overlaps with the hidden one(s). Right click and select Unhide and they’ll appear again. 
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Freeze Panes 

If you have a large amount of data with labels in the first row or column (or both), you may want to keep 
those labels visible at all times. A neater option for this to Freeze Panes. This works similarly to to Split, 
except only for the first few rows or columns. You may also use it at the same time as a separate Split, if 
you’re feeling adventurous. 

To freeze one or more rows or columns, switch to the View tab in the ribbon and select Freeze Panes. 

 

You’ll notice three options. Freeze Top Row and Freeze First Column both do exactly what they say: 
they’ll free the appropriate area and keep it on screen. Freeze Panes works in the same way as the Split 
button did: it will freeze based on the cell you have currently selected. 

Unlinke splits, a freeze can’t scroll and can’t be resized. It’s useful to keep you from accidentally scrolling 
away from your labels with your mouse wheel. 

To unfreeze, simply click the Freeze Panes button again and select the Unfreeze Panes option. 
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Fomatting 

To a scientist, Excel sometimes formats numbers in an odd way. Excel loves to hack away trailing zeros 
or display way too many decimal places. Luckily, adjust what’s displayed is easy. You can also label 
numbers and text, such as homework answers or final calculated values, to make it stand out. 

The Format Cells Dialog 

Right click on any cell in your spreadsheet and click on the Format Cells option. You can also highlight 
any range of cells to change their format all at once. 
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What comes up is the Format Cells dialog: 

 

There are several tabs of options here, but we’ll focus on just a few for now. 

In the Number tab you’ll find a list of ways for Excel to display your cell’s data. Some highlights for an 
average student: 

• General lets Excel do the choosing. This is the default option. 
• Number forces Excel to display a certain number of decimal places, useful when your data has 

significant zeros at the end or when you need to limit the number of sig figs shown. 
• Accounting will line up the decimal places in a column, which is useful for making neat tables. 

Be sure to select the option to turn off the currency symbol if you’re not actually working with 
money. 

• Scientific forces the number to display in scientific/engineering notation. It also lets you specify 
the number of decimal places shown. 

• Text forces Excel to treat the cell like it is filled with plain text, so it won’t try to format a 
number. 

  



 
24 

 

The other options have their time and place but are generally unneeded in most classes. You should 
make a note of them, though. Sometimes you might enter a number and see that Excel has reformatted 
your cell as if you had entered a date or time. In this case, you should go to the Format Cells dialog and 
change the category to Number or Text so things display correctly. 

Also of note in this dialog are the Font, Border and Fill tabs. These will allow you to stylize a cell to make 
it stand out. You probably shouldn’t use anything too flashy in a homework or labwork assignment, but 
making final answers stand out by Filling the cell yellow can make your grader’s life easier. 

Some of the above options are available on the Home tab of the ribbon, too: 

 

The section labeled Font, Alignment, and Number contain a selection of the most-used options from 
their respective tabs in the Cell Styles dialog. You can also click the  button to jump straight to their 
corresponding tabs in the dialog. 
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Adjusting Decimal Places 

Since significant figures are so important to scientific and engineering work, let’s go over how to display 
them correctly. Enter the number “1.23456” into cell A1. 

 

Use the  buttons on the ribbon to adjust the number of displayed decimal places quickly. Notice 
that you can increase the number of displayed digits to include many trailing zeros. You can also reduce 
the number of displayed digits and Excel will round the number accordingly. 

When you reduce the number of displayed digits, Excel doesn’t forget them: you can still use all of the 
digits that you entered in further calculations. Try reducing the displayed digits in A1 to just one decimal 
place and entering “=4*A1” into cell B1. 

 

Even though we’ve rounded the number in cell A1 down to 1.2, Excel still uses the entire number to do 
our calculation. Keep this in mind when you need to report a number to a certain number of significant 
figures but still use the number in future calculations. 
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Cell Styles 

Excel contains several pre-made cell styles to make labeling data fast and easy. On the Home tab of the 
ribbon, you’ll find the Styles group, which contains a list of such styles. 

 

You can click the  button to see the full list of styles. If your screen is too small, you might see a button 
for the styles, instead. Clicking this button will bring up a list of styles to choose from. 

 

In either case, you’ll find a list of styles to help you make certain parts of your spreadsheet stand out. It’s 
not a bad idea to get into the habit of labeling data with these styles as you go when you want to come 
back again later to look at it. 
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Show All Formulae 

When reviewing a spreadsheet, sometimes it’s helpful to see every formula you’ve entered. To see an 
individual formula, you can simply click the cell of interest and look at the formula bar. 

 

 If you’d like to view the formulae for every cell at the same time, navigate to the Formulas tab in the 
ribbon and select the Show Formulas button in the Formula Auditing group. 

 

 

When Show Formulas is active, clicking on any cell will automatically highlight and color code any 
references, allowing you to easily check your work. 

To exit Show Formulas mode, just click the Show Formulas button again. 
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Tables 

Creating Tables 

When you enter data into Excel, it’s a good idea to organize it into a table. Let’s pretend we’ve collected 
some data on a range of concentrations of iron using a spectrophotometer. Enter the following data into 
Excel so you can follow along: 

 

If Excel is cutting off your trailing zeros, remember to use Cell Styles (instructions above). 

This data is fine, but it’s all out of order, and we can make it look a lot better. Click on any cell in the data 
set, then navigate to the Insert tab on the ribbon. Click the Table button in the Tables group. The Create 
Table dialog box will appear. 
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Notice that Excel automatically selected the set of data we entered. If it hasn’t selected the data you 
wanted, click the  button and you can select any group you like. 

Our table has headers (labels on the top cell of each column), so be sure the My table has headers 
tickbox is checked. Then click okay and see the magic. 

 

 

  



 
30 

 

Sorting and Filtering 

 

You’ll notice that Excel has decorated your table to make it easier to read. It’s also created a new tab on 
the ribbon, Table Design. There are some useful features that creating a table like this enables: 

 

The  small arrow button next to each header brings up several sorting options for the data contained 
within. 
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By choosing the appropriate option, we can sort the column in several ways, including by formatting. 
Our data is numerical, so the sorting options are numerical. Text fields can be sorted alphabetically, 
dates can be sorted chronologically, etc. If your data is formatted, you can even sort by the formatting 
options you’ve chosen. 

Additionally, you’ll notice several filtering options, again depending on the type of data in that column. 
Using the filter option, you can display only rows containing specific data. You can even choose the rows 
to display manually. This can be useful for displaying only a given range of data at a time. 

Our data was out of order before, but by selecting to sort smallest to largest we can view the data much 
more easily.  

 

Notice that the arrow button next to the Concentration (ppm) header changed to show the current sort. 
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Table Styles 

Multiple design options are available for tables. You’ll find them in the Table Design tab of the ribbon. 
Note that this tab will only appear if you select a cell within a table. 

 

The Table Styles group contains a list of pre-made styles to choose from. You can click the  button to 
see all of them. 

The Table Style Options group contains tickboxes that will add or remove features of a table. In 
particular, you can hide the header row, add or remove banding (the alternating colors along rows or 

columns), and hide the  button next to each header.  

 

Remove a Table 

To convert a table back to regular cells again, click any cell in the table, then click the Convert to Range 
button in the Table Design tab in the ribbon. 

 

This will keep all the formatting of the table. If you wish to remove that, select all the cells in the former 
table, and select the Normal style in the Home tab.  
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Graphs and Charts 

Excel, for some reason, refers to graphs as Charts. We’ll use the terms interchangeably. Remember that 
the word choice will vary based on the field that you go into the future. 

Inserting a Chart 

Adding a chart is easy, simply navigate to the Insert tab on the ribbon to see your options in the Charts 
group. By hovering your mouse over each button, Excel will bring up a tooltip explaining the chart type. 
The simplest way to plot data is the Scatter Plot, which plots each data point on graph and does nothing 
more. To create one, first enter in data to make the following table: 

 

Select the entire range of data, including the headers, then click the Scatter Plot button. 

 

This brings up a menu with several options. In most scientific contexts we do not want to connect out 
plot points direct, so select the first option, Scatter. 
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Your chart will be placed in the center of your screen. If you hold your mouse over a blank part of the 

chart, the cursor will change to include crossing arrows . This indicates that you can drag the chart to 
another location if you wish. In Excel, charts do not take up a cell. They can be placed anywhere, 
including covering up existing data, so be sure to put your chart somewhere it won’t get in the way. 

 

When you have your chart selected, you’ll notice that two additional tabs are available on the ribbon: 
Chart Design and Format. These contain all the options you’ll need to make your chart perfect. 
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Changing or Adding Data 

Once your chart is placed, you can edit the data it contains by clicking the Select Data button in the 
Chart Design tab of the ribbon. 

 

This will bring up the Select Data dialog: 

 

If the data that automatically populated your chart looks terrible, click the Edit to alter the data or the 
Remove button to start from scratch. To add a new data set, click Add. 
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The Add and Edit buttons lead to the same dialog (except that the fields will already have data in them if 
you clicked Edit). The dialog requests three ranges, representing the name of the series and the X and Y 
values. To select a range, click the  button. Select the appropriate range of data and press Enter. You 
can also type a name into the Series name field if you like. 

Excel likes to put “={1}” in the Series Y values field by default for some reason. You’ll need to delete it 
before you add your own data. 

Using this method, you can add as many data sets to the same chart as you like.  

  



 
37 

 

Trendlines 

You may want to add what Excel calls a “trendline” to you chart. A trendline shows the prevailing trend 
in a chart’s data and, contrary to the name, may be linear or curved. 

To add a trendline, click on your chart, navigate to the Chart Design tab of the ribbon, and select the 
Add Chart Element button. In the menu that appears, select Trendline, followed by Linear. 

 

  



 
38 

 

When the trendline appears, double click on the line to bring up the Format Trendline pane. 

 

There are lots of options here, but we’ll start with the third tab, Trendline Options . Here, you can 
select the shape of your trendline by clicking the appropriate radio button (note that since our data 
contains a zero some of the options are unavailable). Our data is clearly linear, so select that. The linear 
trendline is calculated using the linear least squares method.  

Other options here can be useful in a variety of contexts: 

• Trendline Name allows you to set a name which appears in the chart key, if one is added 
• Forecast allows you to extend the trendline beyond the data points. This is especially useful to 

show the intercepts of the line or to compare to other data. 
• Set Intercept allows you to force the trendline to intercept the y-axis at a specific point. 
• Display Equation on chart will calculate and display the equation of the trendline on the chart. 
• Display R-squared value on chart will calculate and display a value representing how well the 

trendline fits the available data. 

For many scientific contexts, you’ll want to select the Display Equation on chart and Display R-squared 
value on chart options. The values appear on your chart immediately: 
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Once they appear, you can click on the equation and r-squared values and drag them around. Be sure to 
put them somewhere they’ll be legible!  

The other tabs in the Format Trendline pane allow you to alter the appearance of your trendline, but 
these changes are cosmetic only. For now, we’ll leave things as they are. 
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Error Bars 

If your data has error associated with it, you can add several kinds of error bars to your chart to 
represent it. To start, click anywhere on your chart and navigate again to the Chart Design tab in the 
ribbon. Click the Add Chart Element button, then Error Bars. You’ll notice that Excel offers three 
options: error bars based on the standard error or standard deviation of the data set, as well as error 
bars of a set size. While these can sometimes be useful, usually we’ll want to use our own data, so select 
More Error Bars Options. 
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This will place some gigantic error bars on your chart and display the Format Error Bars pane. 

 

If you don’t want error bars on both the vertical and horizontal axes, you can delete them. Let’s delete 
the horizontal error bars by clicking on any one of the horizontal bars and pressing the Delete key on the 
keyboard. 

Next, click on one of the remaining vertical error bars to select them all. Change the Formal Error Bars 

pane to the Error Bar Options tab by clicking the  button. Here you’ll see some design options: 

• Direction allows you to choose to display error on side only if you wish. 
• End Style enables or disables the “cap” at the end of the line. 
• Error Amount allows you to choose how long the error bars are 

If you have a column of data that you wish to use, you can click the Custom radio button under Error 
Amount and select that data. Otherwise, the most typical error bars are based on standard error, so 
select that for our chart. 
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Axis and Chart Labels 

A proper chart has labels on its axes and a title. To add these elements, click Add Chart Element in the 
Chart Design tab of the ribbon, then select the appropriate option. 

     

For most charts, you’ll want to add both horizontal and vertical axis titles, as well as a chart title above 
the chart. Click each option to add them. 

Once they appear on your chart, click once on the chart title to select it. A box appears around the title. 
You’ll notice that if you hover your mouse over the text, your cursor changes to the text edit bar. Click 
again to place the cursor and you can edit the text. Repeat this procedure to label the axes as well. 
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Exporting a Chart to Microsoft Word or Powerpoint 

You might be tempted to take a screenshot of your chart to paste into Microsoft Word, but this can 
result in a blurry or pixelated chart. What’s more, a screenshot isn’t editable. 

Instead, right click the chart and select Copy. Then open your Word document, right click where you’d 
like the chart to go and select Paste. Pasting the chart directly like this has several advantages: 

• The chart can be resized and will always look crisp and clean. 
• The chart can be stretched to a different shape without stretching the text. 
• Chart elements, such as the title or axis labels, can be edited or deleted directly in Word. 

 

The above chart was pasted directly from Excel. You can see how much better it looks than the 
screenshots above, right? 
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Other File Formats 

In addition to the standard XLS and XLSX file formats in Excel, you’ll sometimes be given data in other, 
more generic formats. These require a little bit of work to get correct. 

Opening a CSV File 

Comma Separated Values (CSV) files are an older generic format for saving spreadsheets. While they 
store numbers and text in a grid format similar to Excel’s, they do not store any of the extra information 
that Excel is capable of adding. For this reason, you’ll want to be sure you’re handling these files 
correctly. 

Because CSV files normally open in Excel, you’ll have to pay attention when you download a file to know 
its format. First, check the extension on the file. If the file ends in the .csv extension, you’ll know it’s a 
CSV file. Many computers are configured to not show file extensions, but Excel will always display the 
extension in its title bar. 

 

If you’re going to be working on a CSV file in Excel, the first thing you should always do is to resave the 
file in XLSX format. 
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To do this, open File in the ribbon, then select Save As. 

 

The Save As window will have the option to change the file format, where you should select Excel 
Workbook (*.xlsx). 

 

Once the file is resaved as an Excel workbook, you can edit it as normal without fear that your 
formatting and charts won’t be saved. 
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Opening a TXT File 

Some instrumentation will export data in TXT format. Usually, Excel will not open these files by default. 
Instead, first open Excel and navigate to File in the ribbon, then click Open, followed by Browse. 

 

In the Open dialog that appears, change the file formats to All Files (*.*). This will allow you to see all 
file formats while you browse. 

 

Browse to your TXT file and open it like normal. Excel will recognize that the file is in TXT format and 
bring up the Text Import Wizard dialog. If the file contains spreadsheet data, it will look something like 
this: 
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The options you select here will depend on the file itself, but Excel is usually smart enough to pre-select 
all the right choices for you. Our example file is comma delimited, meaning it contains lists of values 
separated by commas, and Excel has chosen the correct Data Type already. Click Next to move on. 
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The second page of the wizard allows you to pick the delimiters used in the file. Since our file uses 
commas, we want to check the Comma tickbox but none of the others. Other files will have different 
delimiters, so use the preview to guide you. You’ll notice that the Data preview changes to show the 
data in separate columns when you select the correct delimiter. 
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The final page of the wizard allows you to pre-set the data type. Normally, General will be the correct 
choice, especially if your document contains data. You can always change the data format later using the 
Cell Styles instructions above. Click Finish and Excel will open a workbook with your properly-formatted 
data. 

At this point, follow the instructions in the CSV Files section above to use the Save As command and 
save this file as an XLSX workbook. 
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Keyboard Shortcuts 

Although it can be slightly slow to learn them, keyboard shortcuts in Excel (or any program, really) are 
much faster to use than mouse actions, and they can greatly improve your efficiency. Below are some 
especially helpful keyboard commands that you should be aware of. 

Basic 

TAB – Next Cell – When editing a cell, jumps to the next cell to the right. 

ENTER – Next Line – When editing a cell, jumps down to the next line. If editing multiple cells per line 
and pressing TAB to jump along, ENTER will move the selection all the way back to the left again. 

CTRL+S – Save – Saves the current workbook. Use often! 

CTRL+A – Select All – To select an entire range of data, click any single cell in the range and press 
CTRL+A. Excel will select all non-empty cells touching the cell you selected. Pressing CTRL+A 
again will expand the selection to cover the entire spreadsheet, including blanks. 

CTRL+C – Copy – Stores the highlighted cells to the clipboard. 

CTRL+X – Cut – Stores the highlighted cells to the clipboard and erases them from their current location. 

CTRL+V – Paste – Writes the data in the clipboard to the selected location. 

CTRL+Z – Undo – Takes away the last action you performed. This can be repeated many, many times. 

CTRL+Y – Redo – If the last action you took was Undo, this re-does the action. Using CTRL+Z and CTRL+Y, 
you can step forward and backward through your actions. Note that all “future” actions are 
erased if you perform any action besides Undo or Redo. 

SHIFT+↓, SHIFT+→, SHIFT+↑, and SHIFT+← – Select Multiple Cells – By holding shift while pressing 
arrow keys, Excel will select all of the range that you move the selection over. 

CTRL+↓, CTRL+→, CTRL+↑, and CTRL+← – Jump to Edge – By holding control and pressing an arrow 
key, you can jump to the edge of a large data set. Excel will select the last cell in the chosen 
direction before a blank or before the edge of the spreadsheet. 

CTRL+ SHIFT+↓, CTRL+ SHIFT+→, CTRL+ SHIFT+↑, and CTRL+ SHIFT+← – Select to Edge – Combining 
the above two commands will select all cells from the selected cell to the edge of the data. If 
you select the upper left cell in a set of data, you can press CTRL+SHIFT+→ then CTRL+SHIFT+↓ 
to quickly select the entire range. 

CTRL+D – Fill Down – Highlight a cell and multiple empty cells below it and press CTRL+D to copy the 
formula in the first cell into all the other highlighted cells. 

CTRL+R – Fill Right – Highlight a cell and multiple empty cells to the right and press CTRL+R to copy the 
formula in the first cell into all the other highlighted cells. 

CTRL+1 – Format Cells – Use this command to quickly open the Format Cells dialog. 
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CTRL+SHIFT+= (CTRL + SHIFT + equals) – Insert – Opens the Insert dialog, allowing you to insert a cell, 
row, or column next to the current selection. 

CTRL+- (CTRL + minus) – Delete – Opens the Delete dialog, allowing you to remove a cell, row, or 
column. 

ALT+ENTER – Line Break – When editing a text cell, pressing ALT+ENTER adds a line break, rather than 
jumping to the next cell. 

 

Function Keys 

F1 – Open Excel Help – Opens the Help pane on the right side of the window, but you’re an expert now, 
right? 

F2 – Edit Cell – Moves the text cursor inside the cell to allow you to edit its formula. 

F3 – Paste Name – Opens the Paste Name dialog box (not covered in this tutorial) 

F4 – Cycle Cell References – Cycles the reference at the text cursor between relative, absolute, and 
mixed reference types. 

F5 – Go To – Opens the Go To dialog, where you can enter any cell reference to move the selection 
there. 

F6 – Change Pane – Changes the currently active pane if Split has been used. 

F7 – Spell Check – Opens a dialog to check the spelling of text 

F8 – Extend Mode – Enables you to select a range of cells without holding SHIFT. Press F8 again to 
disable Extend Mode. 

F9 – Recalculate – Although Excel automatically recalculates all cells whenever you make a change, you 
can manually force a recalculation with F9. 

F10 – Show Key Tips – Displays keyboard shortcuts for ribbon commands. To execute a command, hold 
ALT and press the corresponding key. 

F11 – Quick Chart – Creates a chart based on the currently selected data (not recommended) 

F12 – Save As – Allows you to quickly save the current workbook under a new name. 
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Functions of Interest 

Some very useful functions are listed below. It would be a good idea to become familiar with all of them. 

Functions are listed in the following format: 

FUNCTION_NAME(required_argument_1, [optional_argument], […]) 

The function name is listed in all caps. 
Arguments that are required to make the function work are listed in parentheses immediate after. 
Optional arguments are listed inside brackets, these can be ignored if they are not needed. 
[…] indicates that you can add additional arguments if you desire, but they are not required. 

When referencing the result that the function puts out, we say that a function returns a value. 

List of Functions 

SUM – SUM(value1, [value2], […]) – Returns the additive sum of all values selected. 

VLOOKUP – VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup]) – Searches through 
the table_array to find the lookup_value. If found, returns the value in the column or 
the table_array according to col_index_num. If range_lookup is set to 0, this looks for an 
exact match only, otherwise it will return the closest value available. 

IF – IF(logical_test, value_if_true, value_if_false) – Performs the logical test in logical_test. If the result is 
true, returns value_if_true, if the result is false, returns value_if_false. Examples of 
logical tests are strings such as “A1=3”, “A2>A3”, and “SUM(A1:A3)>A4”. 

IFS – IFS(logical_test, value_if_true, […]) – Similar to IF, except you can list as many logical tests as you 
like, each followed by its own value_if_true argument. If none of the listed logical_tests 
are true, returns an error. 

COUNTIF – COUNTIF(range, criteria) – Counts each cell in range that satisfies criteria and returns the 
count as a number. Examples of criteria are strings such as “>10”, “A1”, and “15”. 

COUNTIFS – COUNTIFS(range, criteria, […]) – Similar to COUNTIF, but allows for up to 127 sets of range 
and criteria. 

SUMIF – SUMIF(range, criteria, sum_range) – If criteria is met by range, sums all values in sum_range. 

SUMIFS – SUMIFS(range, criteria, sum_range) – Similar to SUMIF, but allows up to 127 sets of range, 
criteria, and sum_range. 

ROUND – ROUND(number, num__digits) – Rounds number down to the specified number of digits using 
standard rounding rules. 

ROUNDDOWN – ROUNDDOWN(number, num_digits) – Similar to ROUND, but always rounds toward 
zero. 



 
53 

 

ROUNDUP – ROUNDUP(number, num_digits) – Kills weeds. Similar to ROUND, but always rounds away 
from zero. 

MROUND – MROUND(number, multiple) – Similar to ROUND, but rounds to the nearest multiple of 
multiple. 

AVERAGE – AVERAGE(number1, [number2], […]) – Returns the arithmetic mean of all arguments. 

STDEV – STDEV(number1, [number2], […]) – Returns the standard deviation of a sample (given as 
arguments). 

STDEV.S – STDEV.S(number1, [number2], […]) – Returns the standard deviation of a sample (given as 
arguments). Exactly the same as STDEV. 

STDEV.P – STDEV.P(number1, [number2], […]) – Returns the standard deviation of the arguments, 
assuming that the arguments represent the entire population. 

F.TEST – FTEST(array1, array2) – Returns the result of an F-Test, the two-tailed probability that the 
variances in array1 and array2 are not significantly different. 

NORM.DIST – NORMDIST(x, mean, standard_dev, cumulative) – Returns a normal distribution for x 
based on the specified mean and standard deviation. Returns a cumulative distribution 
function if cumulative=TRUE, returns the probability density function if 
cumulative=FALSE. 

NORM.S.DIST – NORM.S.DIST(z, cumulative) – Returns a normal distribution for z with a mean of zero 
and a standard deviation of one. Cumulative works as in NORM.DIST. 

NORM.S.INV – NORM.S.INV(probability) – Returns the inverse of the standard normal cumulative 
distribution, with a mean of zero and a standard deviation of one. 

T.TEST – T.TEST(array1, array2, tails, type) – Returns the probability of significance according to a 
Student’s t-Test. Tails can be 1 or 2, depending on the number of tails required. Type 
can be set to 1 for a paired t-test, 2 for a two-sample test with equal variance, or 3 for a 
two-sample test with unequal variance. 

COUNT – COUNT(value1, [value2], […]) – Counts the number of cells in the range that contain numbers. 

COUNTA – COUNTA(value1, [value2], […]) – Counts the number of cells in the range that are not empty. 

ABS – ABS(number) – Checks to see if you’ve been doing your crunches. Returns the absolute value of 
number. 

LOG10 – LOG10(number) – Returns the base-10 logarithm of number. 

LOG – LOG(number, base) – Returns the logarithm of number to the specified base. 

PI – PI() – Returns π accurate to 15 digits, 3.14159265368979. 

RAND – RAND() – Returns a random number in the range [0,1). The number changes each time the 
spreadsheet is recalculated. 
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CONFIDENCE.T – CONFIDENCE.T(alpha, standard_dev, size) – Returns a confidence interval for a 
population mean using a Student’s t-Test distribution. 

CONFIDENCE.NORM – CONFIDENCE.NORM(alpha, standard_dev, size) – Returns a confidence interval 
for a population mean using a normal distribution. 

LINEST – LINEST(known_ys, known_xs, [const], [stats]) – Returns statistics on a linear trend of the data 
in known_ys and known_xs. If known_xs is left out, Excel will use the list {1,2,3…}. Const 
can be set to FALSE to force the trendline to intercept (0,0). Stats can be set to TRUE to 
return additional statistics. 

MAX – MAX(number1, [number2], […]) – Returns the largest value in the set of arguments. Ignores text. 

MODE - MODE(number1, [number2], […]) – Returns the most frequently occuring value in the set of 
arguments. 

MODE.SNGL – MODE.SNGL(number1, [number2], […]) – Returns the most frequently occuring value in 
the set of arguments. Identical to MODE. 

MODE.MULT – MODE.MULT(number1, [number2], […]) – Returns the most frequently occuring value in 
the set of arguments, but returns multiple values if applicable. 

MIN – MIN(number1, [number2], […]) – Returns the smallest value in the set of arguments. Ignores text. 

MEDIAN – MEDIAN(number1, [number2], […]) – Returns the middle value in the set of arguments. 
Ignores text. 

RANK – RANK(number, ref, [order]) – Returns the rank of number in the array ref. If order is 0 or 
omitted, ranks ref in descending order. If order is 1, ranks ref in ascending order. 

Further Reading 

Microsoft’s Excel support website has detailed descriptions of all functions and options in Excel: 
https://support.office.com/en-us/excel. 

Much information in this guide was adapted from online tutorials at https://www.excel-easy.com/ and 
https://www.guru99.com/introduction-to-microsoft-excel.html. 

The Best in the World: At What I Have No Idea by Chris Jericho & Peter Fornatale (ISBN: 1592409431) is 
just an excellent read that has nothing to do with Excel whatsoever. 

https://support.office.com/en-us/excel
https://www.excel-easy.com/
https://www.guru99.com/introduction-to-microsoft-excel.html
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